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ABSTRACT

The fascinating field in present civilization scenario at the edge of science is micro-swimmers,
which is a combination of bio physics with self-propulsion mechanisms involving swimming
strategies at low Reynolds number. These microswimming robots offer many advantages in
biomedical applications such as drug delivery to some specific locations in our human body and

also conducting some surgical operations like opening of blocked arteries etc.

In recent times, blocked arteries becomes a major case in the medical world. This is can
be diagnosed by AngioPlasty(is a minimally invasive, endovascular procedure to widen
narrowed or obstructed arteries or veins, typically to treat arterial atherosclerosis) method. So

this is the main reason to choose the aorta as our domain for analysis purpose.

In this we present a micro-swimmer with three different heads they are spherical head,
Capsule type head and Tapered cylindrical or elliptical head. We model them using
SOLIDWORKS and analysis in ANSYS FLUENT.
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CHAPTER 1

l. INTRODUCTION
Micro-swimmers are the bio-hybrid micro-robots consisting of artificial microstructures. It is
designed mechanically with self-propulsion. This is the application of engineering principles
and technology to medicine and biology for healthcare purposes. In the present situation of
medical life, it is necessary to close the gap between engineering and medicine for advanced
health care treatment. Micro-swimmer is the next step for that, having wide range of
applications. It is able to travel in the human body through the Arteries, then it can treat the
entire body internally and can give the information and report of every part of the body. As
arteries of a human body looks like a thin wire, then the micro-swimmer which will be
induced in it should be in micro level. So here the design of micro-swimmer matters very
important and it is very complicated. Hence our main agenda is design, analysis and
dynamics of mechanical micro-swimmer. Tiny swimmets, be they micro-organisms or micro-
bots. live in a world dominated by friction. In this world, technically, the world of low
Reynolds numbers, motion is associated with energy dissipation. In the absence of external
energy supply objects rapidly come to rest. It is both conceptually interesting, and
technologically important, for example in applications to nano-medicine . to try and
understand what classes of strategies lead to effective swimming in a setting dominated by
dissipation. A particularly promising class of strategies is where the motion is, in a sense,

only apparent; where a shape moves with little or no motion of material particles.

Artificial micro- nano-robots have attracted lots of researchers to carry on extensive study
due to their considerable promise for diverse biomedical tasks such as targeted therapy, tissue
removal and micro-manipulation. Purcell found the advantages of the nonreciprocal motion
and demonstrated two efficient swimming modes at low Reynolds number the flexibleoar and
the corkscrew. Although Qiuetal presented a micro-swimmer that moves with reciprocal
periodic body-shape changes in non-Newtonian fluids, its propulsion performance depended

on the fluid viscosity upon varying the shear rate.

Recently, more attention has been focus on helical magnetic micro-swimmers which can
convert the rotation energy along their helical axis into the translation energy actuated by the
uniform magnetic field. Generally speaking, there are two major physical mechanisms to
generate a propulsion force in the small scale to overcome the drag force exerted by the

surrounding liquid: “inertia propulsion™ and “viscous propulsion”. The inertia propulsion



e swimming body and

generates displacements of mass to exchange momentum between th
ounding fluid

the surrounding fluid. The viscous propulsion uses viscous stresses with the surr

to generate a propulsion force. To classify these two propulsion mechanisms, the Reynolds

number (Re). which stands for the ratio between the inertia force and the viscosity force, is

commonly used. The Reynolds number is defined by UL/v, where U is the ¢
), L the characteristic physical

haracteristic

velocity (can be the propulsion speed or actuator speed

dimension (swimming body size or actuator size) and v the kinematic viscosity of the fluid.

For the large Re, the inertia force is dominantly responsible for propulsion while for the small

Re the viscous force is responsible. As the physical dimension critically affects Re, a suitable

he size of the propulsion object

propulsion mechanism should be selected and used based on t
has been a topic of

or actuator. The locomotion of microscopic organisms, such as bacteria,

fascination and mathematical analysis for well over sixty years.

1.1 ORIGIN OF MICRO-SWIMMERS:

Apart from seeking fundamental knowledge about how these evolutionarily

simple organisms move and interact with their environment, there has recently been great

interest in mimicking or using bacteria as micro-robots with biomedical and environmental

monitoring applications. Of particular interest are magnetotactic bacteria, which can readily

be steered by applying magneti

also be controlled with magnetic fields afte
y been demonstrated with the alga Chlamydomonas reinhardtii. Commonly studied

¢ fields. Organisms that are not naturally magnetotactic can

r incorporation of magnetic particles; this has

recentl

magnetotactic bacteria include the strains MO-1 and MC-1 (Magneto coccus marinus), which

are similar in morphology and differ from the species most widely studied in other contexts,

such as Escherichia coli, Bacillus subtilis, or Vibrio alginolyticus. For in vivo biomedical
applications, micro-swimmers need to find an obstacle-free path and make themselves along
h the tasks of targeted therapy and targeted drug delivery. For

the planned path, to accomplis
manual operation, this would allow for considerable time and skilled operators. The manual
control method is an open-loop tele-operation without any feedback. Related studies have
been reported in the literature for different operation spaces, such as operation in a micro-
fluidic chip in 3D space, and in vivo operation and for different driving methods, such as
bacteria-driven operation and chemically driven operation. The manual control method is not

appropriate for tasks that require high repetition with high precision.



1.2 MOTION OF MICRO-SWIMMER:

Micro swimming robots offer many advantages in biomedical
applications. such as delivering potent drugs to specific locations in targeted tissues and
organs with limited side effects, conducting surgical operations with minimal damage to
healthy tissues. treatment of clogged arteries, and collecting biological samples for diagnostic
purposes. Reliable navigation techniques for micro swimmers need to be developed to
improve the localization of robots inside the human body in future biomedical applications.
In order to estimate the dynamic trajectory of magnetically propelled micro swimmers in
channels, that mimic blood vessels and other conduits, fluid-micro robot interaction and the
effect of the channel wall must be understood well. In this study, swimming of one-link
robots with helical tails is modeled with Stokes equations and solved numerically with the
finite element method. Forces acting on the robot are set to zero to enforce the force-free
swimming and obtain forward, lateral and angular velocities that satisfy the constraints.
Effects of the number of helical waves, wave amplitude, relative size of the cylindrical head

of micro swimmer and the radial position on angular and linear velocity vectors of micro
swimmer are presented.

The hydrodynamic characteristics of micro-swimmers can be achieved by
in the Ansys-fluent by adding corresponding values of flow

s and other animals that delivers necessary

the step wise analysis

medium(blood).Blood is a body fluid in human

substances such as nutrients and oxygen to the cells and transports metabolic waste products

away from those cells. It has some standa
e velocity vector curves and boundary layer analysis of micro-

rd values like velocity, pressure, density, etc., by

providing these data, th
swimmers can be developed. These swimmers actually a size of microscopic level and
therefore the body may not feel the movement of thi
swimmers can have the self propulsion capability when

s micro-swimmer in the arteries. Many of

the researches showing that micro-

fabricated with a combination of mechanical an
e very difficult to fabricate such complex structures in the

d electrical devices to give them self actuation

and then motion, but this will b
micro size swimmer. So these micro-swimmers are preferable to be worked by an external
agent. The most preferable media to make them mo
and in the presence of a magnetic field it will move.

ve is the magnetic field. Magnetic

properties can be given to the swimmer

The head of micro-swimmer should be made with a magnetic material. We have different

ferromagnetic materials available on our carth. We select the best material from these

different materials with the in-toxic and high magnetic strength. The helical tail also has to be




made with some magnetic matenals. GaAs is the material mostly used to fabricate the tail of
the micro-swimmer. This tail is to be attached to a soft nickel spherical body on one side.
quthors demonstrated the forward motion of the structure in the direction of the helical axis
by applyng rotational magnetic field in that direction and pointed out that linear swimming
velocity was affected not only by the size of the magnetic head, but also the strength of the
apphed magnetic field. Cobalt is another ferromagnetic material used for the fabrication of
the micro-swimmer head deposited on one side of the micro-swimmer. Varying the magnetic
field strength can give the movement to the micro-swimmer. The blood properties should not
change with the magnetic material used. The research journals have been showing that these
micro-swimmers first experimented in the water and then by correlating the properties of

blood with water.

1.3 CLASSIFICATION OF MICRO-SWIMMERS: |

There are different types of heads of micro-swimmers but all of these may not show same
hvdrodynamic characteristics in the fluid media. The properties may change due to the shape {
of head and tail as they are the only reason for the propulsion. Universally accepted models
are solid spherical head and the sperm head. According to the flow and velocity of blood, we
should concem the design of head. The head should be structurally tough enough and have a
suitable shape for the propulsion. So we considered three types of heads for analysis and 4

simulation. They are spherical head, sperm head and cylindrical head. |

Fig 1.1 Spherical Head Microswimmer

The Spherical head micro-swimmer design is not a complicated task compared to other
des N .
CS1gns, Geometry of this micro-swimmer can make ease of swimming through any fluid

Media This i the foremost design used in any application. As its head is spherical, the

T



propulsion in the fluid is very smooth. When the fluid strikes the head on the front part,

poundary layer forms around the sphere and pushes the swimmer forward Hence the

swimmer moves easily with this technique.

Figl 2 Capsule Head Microswimmer

The second design has a band head with helical tail. It looks like a capsule, so named after
it. It is a basic three dimensional geometric shape consisting of a cylinder with hemispherical
ends. Another name for this shape is spherocylinder. This shape is usually used for containers
for pressurized gases and for pharmaceutical capsules. Comparing with other designs, it has
more space for accommodation of extra payload. This design also is somewhat better for
swimming technique, as its ends are semispherical. Hard spherocylinders provide a good

model for colloidal particles with short ranged repulsive interactions.

&=

Fig!.3 Elliptical Head Microswimmer

The third design is sperm like head micro-swimmer with a helical tail. This is the most
efficient design in any fluid dynamics having exceptional hydrodynamic characteristics

ompared to other two designs. This design used in every application like, the cockpit of an

B



aeroplane, design of bullet shape, foremost part of a rocket. This design is also can be named
45 aerofoil shape as it have less drag forces compared to other designs. This is the basic ideal

Jesign taken from the sperms of living beings.

Apart from the individual characteristics, these are the mostly used designs almost in all
research journals, so we considered these as the reference models for our analysis of

E.ﬁ_a%:mamo characteristics.

1.4 RELATION OF PARAMETERS:

In physics and engineering, fluid dynamics is a sub discipline of fluid mechanics that
describes the flow of fluids- liquids and gases. It has several sub disciplines, including
aerodynamics and hydrodynamics. Fluid dynamics has a wide range of applications,
including calculating forces and moments on aircrafts, determining the mass flow rate of
petroleum through pipelines, predicting weather patterns. The fluid dynamic analysis can
give the information about how the hydrodynamic forces and other parameters act on the
bodies when they tend to move or when placed at a position in a fluid flow. In fluid
dynamics, drag (sometimes called fluid resistance) is a force, acting opposite to the relative
motion of any object moving with respect to a surrounding fluid. This can exists between two
fluid layers or between a solid and a fluid layer. Unlike other resistive forces, such as dry

friction, which are nearly independent on velocity, drag force depends on velocity.

Drag force is proportional to the velocity for a laminar flow and the squared
velocity for a turbulent flow. There are different types of drag l.parastic drag 2.form drag
3.skin friction 4.interference drag 5.lift induced drag 6.wave drag. Drag mainly depends on
the shape, size, and speed of the object.

One way to express the drag force is
Fp 1p*CpA
where
F -is the drag force,
D - is the density of the fluid
V - is the speed of the object relative to the fluid.
A - is the cross sectional arca and
Symbol rho - is the drag coefficient —a dimensionless number.

The drag coefficient depends on the shape of the object and on the Reynolds number.



Where D is some characteristic diameter or linear dimension and v is the kinematic viscosity
of the fluid. At high Reynolds number the drag cofficient is more or less constant and drag
will vary as the square of the speed. These are the parameters that effect the motion of a

microswimmer in the fluid medium.



CHAPTER 2

LITERATURE REVIEW

Gwimming micro-robots have great potential in biomedical applications such as targeted drug
delivery. medical diagnosis. and destroying blood clots in arteries. Inspired by swimming
microorganisms, micro-robots can move in bio-fluids with helical tails attached to their
podies. In order to design and navigate micro-robots, hydrodynamic characteristics of the
flow field must be understood well. This work presents computational fluid dynamics
modeling and analysis of the flow due to the motion of micro-robots that consist of magnetic
heads and helical tails inside fluid-filled channels akin to bodily conduits; special emphasis is
on the effects of the radial position of the robot. Time-averaged velocities, forces, torques,
and efficiency of the micro-robots placed in the channels are analyzed as functions of rotation
frequency, helical pitch (wavelength) and helical radius (amplitude) of the tail. Results
indicate that robots move faster and more efficiently near the wall than at the center of the
channel. Forces acting on micro-robots are asymmetrical due to the chirality of the robot’s
il and its motion. Moreover, robots placed near the wall have a different flow pattern
around the head when compared to in-center and unbounded swimmers. According to
simulation results, time-averaged forward velocity of the robot agrees well with the

experimental values measured previously for a robot with almost the same dimensions.

Some of the references taken for the future study and analysis of hydrodynamic

characteristics of micro-swimmers are as follows:

Gray and Hancock et al. [1] (1955) modeled swimming of a sea-urchin spermatozoa based on

the fluid forces calculated by the resistive force theory, which offers a general framework for

the calculation of the resultant propulsion and drag forces from the integration of local forces

in normal and tangential directions that are proportional to the velocity components in those
directions over the tail.

interactions of swimming organisms with

Berke et al. [2](2008) investigated hydrodynam

solid surfaces by measuring the distribution of E. coli swimming between glass plates and

compared their results with a hydrodynamic model.

Najafi ¢t al. [3] proposed another model with lincarly nked three spheres for a micro robot

that is operated based on the periodical internal motion. According to the numerical study,

this swimmer could also work in the low Reynolds number range.



Howse ¢t al. [4] coated half of the polystyrene sphere (diameter 1.62 pm) with platinum.
when this particle was placed na hvdrogen peroxide solution, it was propelled by hreaking
hydrogen peroxide into oxygen and water. In a short time period, the swimming was
,,,,_:2:9_ by the hydrogen peroxide concentration at the speed of several pm’s. However. in
a long ime period. the propelling motion was random. This propulsion mechanism is not

clearly understood yet as of today. though there have been two explanations introduced: the

osmotic propulsion model and the bubble detachment propulsion model.

Dr. dieter breitschwerdt et al. [5] From a physical point of view. in particular the motion of
microorganisms has attracted a lot of attention [12]. Their motion at small scales is mainly
governed by viscous forces which dominate over inertial forces, quantified by a small
Reynolds number. At low Reynolds numbers microswimmers have to perform non-reciprocal

deformations of their cell body in order to swim in the absence of external forces and torques.

Bradely jNelson et al. [6] —Wireless magnetic micro-robots show great potential for
targeted drug delivery or as minimally invasive surgical tools in the human body. In order to
swim through bodily fluids. such as the vitreous humor in the eye, they must be equipped to
successfully move through visco-elastic fluids, where they are obstructed by fibrous networks
or microparticles. Prior researchers have shown an increased propulsion efficiency with

increasing viscoelastic properties for artificial helical swimmers and bacteria with helical
flagella.

Zhang et al. and Peyer et al. [7] proposed Magnetic helical microrobots, powered by external
rotating magnetic fields. These microscopic helical swimmers are inspired by the corkscrew
motion of bacteria flagella, such as Escherichia coli or Borrelia burgdorferi. They can

perform 3-dimensional (3D) navigation in various liquids under low-strength rotating

magnetic fields (<10 mT).

A.D. Gilbert etal. [8] One of the simplest magnetically based swimming devices realised in
the laboratory consists of two ferromagnetic beads joined by an elastic element which could

be a vesicle, polymer or protein fibre. The elastic element could also be the component to be

transported in a possible medical application. Rotational motion is driven by the torque from

an external field. At the same time the direction of the external field and the magnetic

anisotropy of the particles influences the directions of the individual ferromagnetic or “soft’

Magnets and the dipole force between them, driving a radial component of motion.
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Lauga et al. [9] Many microorganisms swim close to houndarics, and as a result the effect of
poundaries on fluid-based locomotion has been extensively studied. E. coli bacteria display
circular trajectories near boundarics. clockwise when the wall is rigid and anti-clockwise near

a free surface.

Bernard Bonnard et al. [10] Micro-swimmers were popularized by the seminal presentation
and were analyzed very recently using optimization techniques in a series of articles.
motivated in particular by industrial applications in robotics to design micro-robots whose
control is based on the swimming mechanisms of biological micro-swimmers. In particular
are cent model was proposed into analyze the observed motions of an abundant variety of

zooplanktons called copepods.

Francisco Alarcon et al. [11] Micro-swimmers in 3D can generate coordinated response, such
as a tendency to swim along each other, or create giant density fluctuations induced by the
emergence of a percolating dynamic cluster. We have found that the key factor to produce
these collective motions is the hydrodynamic signature of the micro-swimmers. Since the set-
up of many experiments is a suspension where particles can move in a quasi 2D geometry.

we developed a systematic numerical study such that experimental parameters are simulated.

Joost de Graaf et al. [12] Computationally, hydrodynamic aspects of micro-swimmer
suspensions have been studied using a variety of fluid dynamical solvers, including Stokesian
dynamics, multi particle collision dynamics (MPCD) boundary element methods and lattice-
Boltzmann (LB) simulation. Treating Stokes flow has great advantages from a theoretical
point of view but is often difficult to achieve in simulations. Methods such as LB and MPCD

are constructed to solve the full Navier-Stokes equation, including the inertial term.

Adam Wysocki et al. [13] Both in a natural environment and in micro-fluidic devices, micro-
swimmers usually do not swim in straight but rather in curved or branching micro-channels.
Therefore, the influence of surface curvature on accumulation of micro-swimmers is of great

interest. For example, a polar micro-swimmer close to a flat wall behaves similarly to a polar

particle near a concave surface (e.g., a cavity). This is of high relevance for the design micro-

swimmers with controlled wall-adhesion properties.

U Kei Cheang et al. [14] The rotating flagellum forms a helical traveling wave so it is not a
teciprocal motion. Various artificial helical swimmers have achieved controlled propulsion

under magnetic rotation. The archetypal flexible strategy is the sperm flagellum.
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Nonreciprocal traveling waves propagate down the flexible flagellum to produce propulsion

even for in-plane (hence achiral) beating patterns,

Kathrin E. Peyer et al. [15] In nature, micro-organisms have found numerous ways to propel
themselves, including beating flexible flagella and cilia. Bacterial swimmers, such as the
extensively researched E.coli bacterium, use a molecular motor to rotate helically shaped
flagella. The continuous rotation of a helix is a non-reciprocal motion and, therefore,

perfectly suited for low Reynolds number navigation.
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CHAPTER 3

EXPERIMENTAL SETUP

3.1 TOOLS OR SOFTWARES USED :

o SOLID WORKS
o ANSYS-FLUENT

3.2 SOLIDWORKS :

We used solid works software for the modeling procedure, that is of 2016 version. This
version is released on October 1% 2015 and developed by Dassault systems. Solid works is a
solid modeling computer aided design (CAD) and computer aided engineering (CAE)
computer program that runs on Microsoft windows. However our model is very complicate in
design. but solid works done that easily as it is an user friendly software and utilizes a
parametric feature-based approach. Parametric refers to constraints whose values determine
the shape or geometry of the model or assembly. Design intent is how the creator of the part
wants it to respond to the changes and updates. Features refer to the building blocks of the
part. are the shapes and operations that construct the part. Building a model in solid works

usually starts with a 2D sketch. Solid works files use the Microsoft structured storage file

format.

3.2.1 TERMINOLOGY

These terms appear throughout the SOLIDWORKS software and documentation.

ORIGIN:

Appears as two blue arrows and represents the (0,0,0) coordinate of the model. When a
sketch is active, a sketch origin appears in red and represents the (0,0,0) coordinate of the

sketch. You can add dimensions and relations to a model origin, but not to a sketch origin

PLANE:
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lat construction geometry. You can use planes for adding a 2D sketch,section view of a

mnodel.or a neutral plane in a draft feature, for example

AXIS:

Graight line used to create model geometry, features, or patterns. Youcan create an axis in
different Ways. including intersecting two planes. TheSOLIDWORKS application creates

remporary axes implicitly for every conicalor cylindrical face in a model.

FACE:

Boundaries that help define the shape of a model or a surface. A face is aselectable area

(planar or non-planar) of a model or surface. For example,a rectangular solid has six faces.

EDGE:

Location where two or more faces intersect and are joined together. Youcan select edges for

sketching and dimensioning, for example.

VERTEX:

Point at which two or more lines or edges intersect. You can select verticesfor sketching and )

dimensioning, for example.

3.2.2 USER INTERFACE

The SOLIDWORKS application includes user interface tools and capabilities to help you

create and edit models efficiently, including:

WINDOWS FUNCTIONS

The SOLIDWORKS application includes familiar Windows functions, such as dragging and

resizing windows. Many of the same icons, such as print, open, save, cut. and paste are also

part of the SOLIDWORKS application.

SOLIDWORKS DOCUMENT WINDOWS
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ORKS document windows 2 -
SOLIDW OWs have two panels The left panel, or Manager Pane,
contains:

| FEATURE MANAGER DESIGN TREF -

Displays the structure of the part, assembly, or drawing. Select an item from the feature

manager design tree to edit the underlying sketch, edit the feature, and suppress and

unsuppress the feature or component, for example.

paledl- Y 5
¥ - S
B cabinet_bath (Default< < Default>

112 Sensors

+ |A] Annotations
$= Material <not specified>

& Front

& Top

& Right

L Ongin
+ ﬂ Base-Extrude
' @ Boss-Extrude2
' @ Boss-Extrude3
Cut-Extrudel
Cut-Extrude2

Fig 3.1 Feature Manager Design Tree

2. PROPERTY MANAGER :

This provides settings for many functions such as sketches, fillet features, and assembly
mates.

T

Joss-Extrude o7
v R &
From A

| Sketch Plane -

Direction 1 R
#, | | slind bl |
“ i

A 10 00w :
Xo
L )

Draft outward

Fig 3.2 Property Manager




CONHIGURATION MANAGER
3

ets YOU create, select, and view multiple configurations of parts and assemblies i a
%Q_:a_: Configurations are variations of a part or assembly within a single document For

es_z_,_p you can use configurations of a bolt to specify different lengths and diameters

-1 @ molding Configuration(s) (long)
P& fong [ malding )
? hart [ mokding

Fig3.3 Configuration Manager

323 FEATURES :

Once you complete the sketch, you can create a 3D model using features such as an extrude
(the base of the faucet) or a revolve (the faucet handle). Some sketch-based features are
shapes such as bosses, cuts, and holes. Other sketch-based features such as lofts and sweeps
use a profile along a path. Another type of feature is called an applied feature, which does not
require a sketch. Applied features include fillets, chamfers, or shells. They are called
“applied” because they are applied to existing geometry using dimensions and other
characteristics to create the feature. Typically, you create parts by including sketch-based

features such as bosses and holes. Then you add applied features.

Create the skatch
LiIMmeansion the sketch

Extrude the sketo 1O

Fig 3.4 Extrude Feature
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you ca

in an
girectio!
pand
Compon
tha
Collisto!

no:aco:ma.

combine multiple parts that fit together to create assemblies You integrate the parts

assembly using Mates, such as Concentric and Comcident. Mates define the allowable
1 of movement of the components. In the faucet assembly, the faucet base and
Jes have concentric and coincident mates. With tools such as Move Component or Rotate
ent, you can see how the parts in an assembly function in a 3D context. To ensure
¢ the assembly functions correctly, you can use assembly tools such as Collision Detection

.on Detection lets you find collisions with other components when moving or rotating a

¥
Sketch-based features: Gase sweep for
the waste oipe
Applied feat.re: Flllets for rounding off edges i
i

Fig 3.5 Assembly of parts “wi

325 DRAWINGS :
| ol
- You create drawings from part or assembly models. Drawings are available in multiple views {
such as standard 3 views and isometric views (3D). You can import the dimensions from the \ |

model document and add annotations such as datum target symbols

s ¥V
,. Views
H I

Fig3.6 2-D Drawing Sheet

lsometric
view
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Round face on the faucet handle Round face on the stem

Fig 3.8 Concentric Mate

3.3 ANSYS:

Ansys-Fluent is used for the simulation of the model designed in the solid works. Fluent
software contains the broad, physical modeling capabilities needed to model flow, turbulence,
heat transfer and reactions for industrial applications. These range from air flow over an
aircraft wing to combustion in a furnace, from bubble columns to oil platforms, from blood
flow to semiconductor manufacturing and from clean room design to wastewater treatment
plants. Fluent spans an expansive range, including special models, with capabilities to model

in-cylinder combustion, aero-acoustics, turbo machinery and multiphase systems.

Fluent also offers highly scalable, high performance computing (HPC) to help
solve complex, large-model computational fluid dynamics (CFD) simulations quickly and
cost-effectively. Fluent already solves the toughest design challenges with well-validated
results across the widest range of CFD and multi-physics applications. But today, engineers

need to accomplish more, in less time and with less training than ever before introducing the

new way to enjoy CFD simulations.
3.4 ANSYS WORKBENCH:

The ANSYS Workbench interface consists primarily of a toolbox region, theProject
mosm:._m:ov the toolbar, and the Menu bar. Depending on the analysis type and/or application
or workspace, you may also other windows, tables, charts, etc. One way to work in ANSYS

Workbench is to drag an item such as a component or analysis system from the toolbox to the



19

{ schematic or to double-click on an 1tem to mitiate the default action You can also use

ﬁﬂb._rar‘
; COS s AT
(he context menus. accessible from a nght mouse click, for additional options You will
vour analysis systems in the components that make up vour analysis in the project schematic

including all connection and links between the systems The individual applications in which

vour work will display separately from the ANSYS Workbench GUI, but the results of the

actions you take i the application may be reflected in the project schematic. The ANSYS
?oarcm:nr interface is arranged into two primary arcas the toolbox and the project
schematic. The toolbox contains the system templates where you will manage your project In
addition. you will see a toolbar and a menu bar with frequently used functions To start a new
analysis, select a system from the Toolbox and double-click or drag it onto the Project
Schematic. An analysis system block appears in the Project Schematic. It will contain the
components, called cells, required to complete the analysis, as well as optional components

such as Resources. Items that must be completed before you can continue are indicated with

an Attention required state indicator.

A rencesbic act - Serench
> g Dab U G Me v

Jad@ e

7 ashech ot AdsePued 5 ACT SlariPags

b

sceceeEnNIIRencos

" DE8C

stans

. - -

Fig 3.9 ANSYS Workbench

After you add an analysis system, you can load an existing geometry by nght-
clickj .
icking on the Geometry cell of the analysis system and choosing Import Geometry from the
o . . .
text menu. After you import geometry, you can edit 1t in Design Modeler by selecting

Edi . S
1t from the context menu. Once your geometry Is complete to your satisfaction, right-click
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Setup cell and select Edit. Your model will open the appropriate application (CFX.

FLUENT. etc.). From there. you can set up your model and solve your analysis

o e

yS
ANSY>- . .
o the t00ls and features of that application. To open Design Modeler and create a new

ety right click on the Geometry cell and choose New Geometry. You can then build

_ pew geometry in the Design Modeler window that opens. Alternatively. you can add a

youl

Wim: \iodeler system to the Project Schematic. The use of Finite Element Analysis for the
<ructural engineering is an important advantage. The design of the structural not only
henefits- but may require the use of this advanced analysis approach. The nature of structural
-omponents involves several concerns and requirements. Safety. reliability. strength.
iffness. and low cost all come into the picture. Coupled with this. are the additional design
requirements of interference. manufacturability, and over all function. By using finite element
modeling as a primary analysis tool, the constraints of creativity are removed. It provides a

mcaaa.:_ procedure t0 mathematically model physical phenomenon

3.5 THE BASIC PROCEDURE IN ANSYS WORK BENCH

1. Select vour desired analysis system from the Toolbox (at left). drag it into the
Project Schematic (at right). and drop it inside the highlighted rectangle.

2. Right-click on the Geometry cell to create a new geometry or import existing
geometry.

3. Continue working through the system from top to bottom. Right-click and

selected ton a cell to start the appropriate application and define the details

for that part of the analysis.
As you complete each task. a green check mark appears in the cell. indicating that

vou can proceed to the next cell. ANSYS Workbench automatically transfers your

data between cells. When you select Save (either from the ANSYS Workbench

window Orin an application), the entire project is saved. You can connect systems to

build more complex projects.

Access 1. Double-click the Engineering Data cell or right-click the

| and select Edit...

m:mmsnnlsm Engineering Data cel

In the Data.

s



 Import data
_ into a

Data source.

1. Access Engineering Data.

2. Select a data source in the Outline Filter pane.

3. Check the Edit library box to the right of the data source
Title.

4. Choose File> Import Engineering Data....
5. Select a file and choose Open.

Note: Only recognized data will be imported into the data
Source.

1. Access Engineering Data.

2. Select a data source in the Outline Filter pane. W
Export a Data 3. Choose File> Export Engineering Data.... ?.
Source 4.In the Save As dialog, select the folder, provide a _
Filename, and choose Save. "
|
|
1. Access Engineering Data.
2. Select a data source in the Outline Filter pane.
Export 3. Select one or more items in the Outline pane.
Individual 4. Choose File> Export Engineering Data....
Data 5. In the Save As dialog, select the folder, provide a
| Filename and choose Save.
w L

3.6 FLUENT:

.

FLUENT is a commercially sold CFD program that is widely accepted for its high fidelity.
The Program has many different capabilities and functions. Both 2-dimensional and 3-
&En:wmozm_ cases can be tested with laminar, inviscid, or turbulent flow. Depending on the

Model and flow type. the designer chooses which flow field type is best. For large models,
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over 200,000 cells and a coupled solver, a standard PC with single memory cannot process

he model. Super computers with multiple processors must be used to solve these larger

models- The following are the steps followed to run a FLUENT model.

step 1 Create a CATIA model and import it in ICEM CFD. Create a domain around the

model and do the structured meshing of the same. It is meshed with medium sized clements

as the siz€ of the mesh will dramatically affect the accuracy of the results and the processing
time.

step 2: Export the mesh into FLUENT.

step 3: With FLUENT opened, select either 2-D or 3-D, depending on the mesh created in
CATIA. There is also 2ddp and 3ddp. The “dp” stands for double precision. and is more
accurate than just the standard 2d or 3d. Case run time is larger for this method. but the

accuracy of the results is important to the validity of the model.

Step 4: Import the mesh and run a check to see if there are errors in the mesh. The size of the
mesh can also be seen to verify that there are not too many cells to run the test on a standard

PC.

Step 5: Choose the type of solver: segregated or coupled. Coupled solver requires much more

computer memory. The solver is the method that the program uses to solve the equations.

Segregated solver- solves the equations one by one e.g. equation of momentum, continuity,

energy (if compressible flow) and turbulent factor. Then check for convergence.

Coupled solver- solves the same equations as the segregated solver, but does this

simultaneously instead of one by one.

Step 6: Choose the type of flow: laminar, invisid, or turbulent. If choosing turbulent flow
select the turbulent model to use. It is difficult to determine the most accurate turbulent model
Wwithout testing several different ones. The accuracy depends on the mesh shape and tlow

pattern,

Step 7: Set the fluid properties and boundary conditions. The fluid properties include but are

not limi N
"ot limited to density, viscosity, velocity, wall friction, and much more.

w~. . Q . . i g e
P 8: Select the solution controls and discretization methods. This depends on the shape of

the . . . L
¢ body and type of flow. A description of each solution and discretization method should be

T
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: h . .
o the designer chooses which one is best for their model. The FI.UENT online hel
. UENT online help

cad pefor
1d be used for these questions.

ment shot!

» SIMPLE and SIMPLE
PLEC are good choices for non-complicated flow

problems (such as laminar flow)
» PISO is used for transient flows

A iduals and t
step % Set the rest urn on what pa
P parameters are to be monitored. For example. the

jift and drag of the body can be monitored.

m—dmv ﬂcu —Hmnﬁﬁ -h:ﬂ: ﬂ—.—ﬂ S i O——cﬂnmow _.~
(] . con OHWO—JOO C mﬂﬂﬂm i i
o-::o: C — € \'4 I on 1Is Qﬂﬂ@—_::_ﬂﬁu UQ

setting the residuals.

ese steps can slightly va
Thes p ghtly vary from mesh to mesh, but in general these ten ste I t
ps allow the user

torun a FLUENT model.
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CHAPTER 4

DESIGN PROCEDURE AND ANALYSIS
| pESIGN IN SOLIDWORKS:
41D

e design of all microswimmers is done by using the SolidWorks software. Here we have
e different geometric models that have to be designed in the SolidWorks.

il Design of heads:

pesign of spherical head:

To create 2 solid sphere in SolidWorks, use the Revolve Boss/Base feature. The steps are
Jescribed below
(reate a NEW sketch.

| Draw a circle with a line intersecting it directly through the centre point with the

required radius of
5 Trim one side of the circle away, leaving the central sketch line as solid.
3. Create a Revolve Boss/Base.

4. Direction Angle should be set to 360°.

5. Accept the feature.

Similarly the other two heads also can be drawn using the standard values from the research

journals. The standard values for a cylindrical head is given by one of the research fellows.

They are as follows:

Table 1. Geometric parameters of models

S —
| Symbol Description Values(um) | Non-Dimensional values
I —
Dy Diameter of the cylindrical head 400 1
I it A
Ly Length of the cylindrical head 600 1.500
A N =
A Wave length of the tail 6025 1.5625
|- | avelengmOTTRE :
B, Wave amplitude 200 0.5
T 1250 | :
' Length of the tail 1250 3.125
~5— e .
" Wire diameter 130 0.325
i —
7\/, Total length of the micro swimmer 1850 4.625
Dy I e
N Length of the channel 1000 2.5
N, ———————— [ 2 | D)
i Number of waves 2 2

R
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Here the values are for a cylindrical head. by taking the diameter of the cylinder we designed

{he .mmo_:ma of sphere. The dimensions are in micro order because of such micro design

These values are taken from the reference paper where they experimented the desired design

?;.38:.,\ in fluid medium

- L. >

4.1 Cylindrical head with a helical tail

4.1.2 Design of helical tail :

After completing design of all the three heads, we have to design a helical shaped tail with
one end attached to the head of the micro-swimmer. For the design of that helical tail the

following steps should be followed.
You can create a helix or spiral curve in a part.
1.In a part, do one of the following:

a. Open a sketch and sketch a circle.
b. Select a sketch that contains a circle.

The diameter of the circle controls the starting diameter of the helix or spiral.

2. Click Helix and Spiral =2 (Curves toolbar) or Insert > Curve > Helix/Spiral .
3. Set values in the Helix/Spiral PropertyManager.
4, ﬂx__n_n v )

-—
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Fig 4.2 Spiral Curve

This helical tail has to be attached to those three different heads by using the assembly
option. The following are the steps to assemble the helical tail and the head

| click on the assembly option.

2. Then go to the mate command and give the required surfaces to be mate.

3.Then adjust the position by giving alignment option.

After assembling the tail to these heads

Capsule Head Elliptical Head

Spherical Head

4.1.3 Design of domain: ‘ .
o send these bodies into it. As we are analyzing the

Then we have to create a domain t
hen flow through the blood, we must consider the

This domain may t
1 is also designed by using the solidworks

hydrodynamic characteristics of bodies W .
akes the geometry of the

domain into which the body has to be send.

largest of the arteries. Its name is Aorta. The domai

Software. The design dimensions of the domain aré
Ascending aorta- length -160mm

diameter- 2. lem/m”2
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_n:mﬁs-uoo:::

. ;ﬁl
mmzm_zm a0 .
pes diameter- 1.6cm/*2
ftais the largest artery in the body. The aorta begins at the top of th le. the
> gorte ™ I .
The T .
's muscular pumping chamber. The heart pumps blood from the left ventricle nto
arts

ay of classifymng a part of the aorta is by anatomical compartment. where the thoracic

on¢ W . . ,
 thoracic portion of the aorta) runs from the heart to the diz phragm. The aorta then

f.ﬁm (©

inues ao;._:ema as the abdominal aorta (or abdominal portion of the aorta) diaphragm o

con
ortic pifurcation.

the @

\nother system divides the aorta with respect to its course and the direction of blood flow. In

his system. the aorta starts as the ascending aorta then travels superiorly from the heart and

then makes 2 hairpin turn known as the aortic arch. Following the aortic arch. the aorta then

fravels inferiorly as the descending aorta. The descending aorta has two parts. The aorta

begins t0 descend in the thoracic cavity, and consequently is known as the thoracic aorta.
After the aorta passes through the diaphragm, it is known as the abdominal aorta. The aorta
ends by dividing into two major blood vessels, the common iliac arteries and a smaller

midline vessel, the median sacral artery.

Ascending aorta:

The ascending aorta begins at the opening of the aortic valve in the left ventricle of the heart.
It runs through a 83.:5: pericardial sheath with the pulmonary trunk. These two blood
vessels twist around each other, causing the aorta to start out posterior to the pulmonary
trunk, but end by twisting to its right and anterior side. The transition from ascending aorta to

aortic arch is at the pericardial reflection on the aorta.

Descending aorta :

The descending aorta is part of the aorta, the largest artery in the body. The descending aorta

begins at the aortic arch and runs down through the chest and abdomen. The descending aorta

a : . . .
Matomically consists of two portions or segments. the thoracic and the abdominal aorta, in

Correg . . I . ..,
espondence with the two great cavities of the trunk in which it is situated. Within the
abd - . .

omen, the descending aorta branches into the two common iliac arteries which serve

th i
€ pelvis and eventually legs.

r
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Descending
Thoracic Aorta

Abdominal
Aorta

v

Fig 4.3 Aorta

Assembly of domain and microswimmer:

a8k el >
v-

€8 Ao ] (Ledeah Dag 2y Stale-1+)
@i

[ sewens

* ) Arncaations

N Tertfase

N Teg Plar:

N Bght s

Loow

v A 1 Dotmits <

Fig 4.4 Assembly of domain and microswimmer
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Fig 4.5 Domain with the spherical head microswimmer

The assembly that obtained is to be in IGS file format so as to move or can import for further

analysis procedure.

4.2 Analysis in ANSYS FLUENT:

Before starting the analysis in the AnsysWorkbench we have to select the fluent fluid flow

from the analysis systems on the left side of the workbench.

OV Uiavl Vvl

A
il Seve wdSave s 2 Julde P Ry sl o, @ 2w wal M

Fhm FaniRIFRT)

Ao ¢ At

| Show P zgraes. mu,.iexh.la J

Fig 4.6 Ansys fluent
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ysis in the fluent consists of five steps. They are as follows

The and

gteps 10 follow for the analysis

| Geometry

Mesh

(]

Setup

(9%

4 Solution

Results

n

GEOMETRY
| Tn this, the IGS file created in the solid works should to be imported here.

2 Now we have to perform Boolean operations to edit the imported geometry.

e <= Eﬂ\
O Anaiyais Sy wemn ~ |
ey
B e -
e o :
@8 exlei Oy 2
& rarion: 318 peh ey
- 4 8 scom q S
s . @ sohen Dia e
s @D Heouts p Trarnfar Data Proes e

Teanater Data Ta Mew

Flnd Flow (rluent)

Uodate
Uprdate Upn s wann Soxrgoun e i

wanzom viDranan B R
Recponse Specinm

Pigia Dy mames

9n90EBEIEEEENNEED

Fig 4.7 Geometry view

3. After performing the Boolean operations, we should update the file to ensure that all
the corresponding parameters are fixed as per the requirement.

MESH

| In this, the updated file is used for meshing.

[

First, we should create names for the design updated. The names can be given by the

left clicking the options and select the named selection option.

[9¥]

After giving the names we should select interfaces to perform the meshing.
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Fig 4.8 Meshing view

4 Then the design is meshed and then click on update option.

o

SETUP:

Meshing | General -
[Mesh Generabon | Mesh

Solution Setup |

Chedk Report Quality
Models
Materials -
Phases | Solver
Cell Zone Conditons | Type Velodity Formulation
Boundary Conditions ‘@ Pressure-Based ‘@ Absolute
tesh Interfaces | . Density-Based ‘Relative
Dynamic Mesh |
Reference Values
Time

Solution ‘@ Steady
Solution Methods .+ Transient
Soluton Controls .
Monitors ﬁ |Gravity
Solution Initialization
Calculation Activities
Run Calculation _In_l

Results

Graphics and Animations

Plots
Reports

Fig 4.9 Setup view
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Zomn_m“

1. The models, materials, cell zone conditions, and the boundary conditions are given in

this option

2

epsilon from them.

Materials:

1. The materials should be given here.

2. Here we taken blood as the fluid and solid iron oxide as body.

3. Blood properties are given as follows.

Select models option and put on the energy option and select viscous, laminar, and k-

Table 2
/ PROPERTIES i STANDARD VALUES
d Density _ 1060 Kg/cubic-metre
ﬁ Specific gravity 3513 J/KgK
ﬂ Thermal conductivity 0.52 W/mK
ﬁ Viscosity 0.003 Kg/m-s

Cell zone conditions:

After inserting the materials, the body has given iron oxide element based on literature

survey and domain is filled with blood and have given the standard values for the blood from

the references.

Boundary conditions:

In this, the inlet velocity and the outlet pressure are given to the domain.
Inlet velocity- 0.66 m/sec

Outlet pressure- 11000 Pa

SOLUTION:

Solution methods:
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Solution Methods

Formulation

Implicit

Fluv Type
Rae-FDS

Spatial Discretization

Gi adient

Leact Squares Call Baced

Flow

Default

Fig 4.10 Solution Method View

Solution initialization:

e hybrid initialization

o standard initialization

ANSYS Fluent will compute and update the Initial Value

Run calculations:

Here we have given 100 iterations to calculate the convergence of the solution, but we got the

Secand Order | inwind
Turbulent Kinetic Energy
Second Order Upwind
Speclfic Cissipation Rate
Sevund Order Upwind

convergent solution at 50 iterations.

Resduals

1e10

1e+05

1e-00

1e-05

1e-10

Te-15

Scaled Residuals

Iterations

can enter new values manually in the fields next to the appropriate variables.

Fig 4.11 iterations view

s based on the conditions

defined at all boundary zones. If you want to change one or more of the values, you

ANSYS

2019 Rt
SCADEME
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pLOT

gy taking velocity on y-axis and position which is default on x-axis, we generated the graph

Options Plot Direction Y Axis Function T
¥ Node Yalues X[ Pressure... M
~ Position on X Axis ; — —=
r Y _- Static Pressure M|

Write 1o File Z[g X Axds Fundion
]
r Direction Vector N
Filz Data H

I

outer-wall

Plot | fxes.. _ Curves...| Close | Help

Figd.12 Plot view



35

CHAPTER 5
RESULTS & DISCUSSIONS

From this analysis. we plotted the graphs of velocity and positions. As we study different
head miCTOSWIMIMETS, the trends of velocity magnitude differs a lot. Blood is the fluid used
for the analysis of these variations as our main concern is all about the Biomedical
applications like drug delivery.

Here we have a domain and blood is flowing in it and the micro-swimmer moves
agamst the flow. At that instance the blood try to push the swimmer along with its flow.
There creates some Reaction force. Due to this the velocity differ at each position of the body
in the domain. The graphs are plotted, taking position on x-axis and velocity magnitude on y

axis. Various graphs are shown below.

Spherical type head with micro-swimmer.

1. Streamlines .

0. ot 00C2 (m)
[ E— —
00005 00015

Fig 5.1 streamlines
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2. Vector .

Fig 5.2 velocity vector

3. Contour .

Fig 5.3 velocity contour
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Velocity Magnitude
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Fig5.4 x-y plot in Ansys

4.Graph:
X -axis — position (m)

Y -axis — velocity magnitude (m/s)
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Capsule type head with microswimmer .

1.Streamlines .

2.0025

Fig 5.4 stream lines

2.Vector .

€ 0002% 000075

Fig 5.5 velocity vector
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Fig 5.6 velocity contour

4.Graph .

,
X -axis — position (m) ~
Y -axis — velocity magnitude (m/s) Y
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Ellipse type head with microswimmer .

1.Streamlines:

ANSYS

N9 R

ACADEMIL

0 00025

Fig 5.7 streamlines

2. Vector:

-
o ) uubS L0 (m) <“m
1

000025 0.00075

Fig 5.8 velocity vector
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3.Contour:
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|
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Fig 5.9 velocity contour

4. Graph:
X -axis — position (m)
Y -axis — velocity magnitude (m/s)
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wall or Domain

% T o]
There should be a reference to compare among three models So we tak d
e . g ¢ aken an empty domain
. d flowing in it. The i "
with bloo 8 velocity magnitude may changes because of the cross-section of

the domain. This helps in comparing the velocity magnitude trends of other three model
O S

1.Streamlines:

T o
u vLx U1 (m) é

[ e Ss—)
00023 20I75

Fig 5.10 streamlines

The streamlines are shown above, as there is no body in the flow, the streamlines are

following a straight path. This would be the optimized condition for the blood velocity.
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N.C_.z_._:
X-axis- position (m)

Y-axis- velocity magnitude (m/s)

0.001 /
4

-0.00068
-0.00056
0.0005
-0.00042
-0.00034
0.00068
0.0008
000088

]
—
o
1=
=]
=]

0.00107
-0.00096
-0.00088

0.0008

-0.00072

0.00018
0.00042
0.00058

The above graphs showing the streamlines, velocity vectors and velocity gradients

of three different heads. But we don't know whether which model is best for the
1 K i 1 . Th /e
application,compared to others. For this, we have taken domain with no body , .m: .s
e graphs with the graphs of three models. The graphs of elliptical
b=

compared these referenc ,
c graphs. So we conclude that it would be the best.

head are somewhat close to the reference
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CHAPTER 6
CONCLUSIONS

1o considered three models of micr :
| The ¢ dels of micro-swimmers were taken from the standard | |
. andard journals
: wsigned and developed in S ;
and desig ped in SOLIDWORKS. The head and tails are created as a single

N sed o e e H H
component based on the required dimensions. Then the part file is converted into 1GS fil
§ orte o 1GS hle to

open the file in ANSYS software.

2. Analysis and flow simulation is done in ANSYS FLUENT under necessary conditions, by

creating a domain for the micro-swimmer. The graphs are presented between velocity and

coﬂ:oi:m of micro-swimmer.

_Then these
3 8 s between the blood

raphs are considered as results, whose are the reaction

and micro-swimmer.

flowing in the aorta, the swimmer will be injected into it.

4. When the blood is continuously
s mechanism for few milliseconds.

y is in rest before the activation of it

The swimmer initiall
flow strikes the swimmer hea

d. In this instance, the

In this small time lapse, the blood
ocity magnitude with respect to position are plotted.

vel
e three different models on the basis of their

omparision between th
is some what having close values

5. Finally we got the ¢
ons. The elliptical he
velocity. This woul

ad type microswimmer

velocity variati
d be the best among three models.

with the reference values of
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